


- Description du produit

La carte PCI4 Usb est une carte contenant 24 entrées/sorties numériques. Cette
carte posseéde aussi deux séries d’interrupteurs permettant de controler les sorties
de 24 bits. Ces entrées peuvent étre utilisées pour faire du contrdle numérique. La
carte se relie par cable USB au PC. La carte utilise une DLL contenant un
composant série qui permet d’envoyer les commandes sur le port série virtuel créé
par le driver FTDI. A I’aide d’une combinaison de commandes et de données,
nous pouvons écrire sur les ports de la carte ou lire un de ces ports. Les
commandes correspondent a une action précise sur les ports du microcontrodleur.
Le tableau ci-dessous vous montre les numéros de commandes ainsi de leurs
utilités. Une DLL et un composant ActiveX fournit, permettrons a 1’usager
d’utiliser les fonctions du protocole d’une fagon simple et efficace. Les principales

fonctions disponibles sont listées et expliquer dans la section DLL ou ActiveX de

ce manuel.
Nom Code ‘HEX Fonction Retour code ‘HEX’
Détection 0x0A Initialisation de la carte PCI4 Usb 0xAB
BitSet 0x2a Positionne un bit a 1 -




Bit Clear 0x3a Positionne un bit a 0 -
LireRO Ox4a Lecture du Port0 Lecture RO
LireR1 Ox4a Lecture du Portl Lecture R1
LireR2 Ox4a Lecture du Port2 Lecture R2
EcrireRO Ox5a Ecriture du Port0 -
EcrireR1 0x5b Ecriture du Port] -
EcrireR2 0x5c Ecriture du Port2 -

Le schéma bloc de la carte PCI4 Usb est le suivant :

Ordinateur PC

Cable Usb

Carte USB <-> Série
(FTDIU232am)

Liaison Série

|

PORTO

Microcontroleur PORT1
(PIC16c64a)

PORT2

Premierement, I’ordinateur PC servira a controler la carte PCI4-Usb. Pour ce faire,
elle utilisera le Port Usb pour communiqué via le cable Usb au convertisseur Usb a
Série. Le convertisseur Usb a Série convertira les données venant du Port Usb en

3




donnée série pouvant étre lu par le microcontréleur. Le microcontréleur
interprétera les données qu’il a regues et exécutera les commandes s'il y a lieu. Les

ports 0, 1 et 2 seront lu ou écrit par le microcontrdleur.

Procédure d’installation :

Matériel :

La procédure d’installation matérielle ne consiste qu’a relier I’interface Pci4-Usb
vers 1’ordinateur hote. Le cable de liaison USB doit étre configuré pour des

connecteurs de Type A vers B.

Une clé dans les connecteurs USB permet d’interconnecter 1’interface vers
I’ordinateur sans inverser la polarité de la connexion. En somme, aucune erreur ne

peut étre faite en reliant I’interface Pci4-Usb vers le PC.

Logiciel :

L’installation logiciel se divise en deux parties : La partie gestionnaire de
périphérique, ‘Driver’, pour la carte Pci4-USB' et la librairie ‘DLL’ ou ‘ActiveX’

qui permet ’accés 4 la carte par les logiciels de controles.

1) Installation de I’Interface Pci4-USB

L’installation de I’Interface USB s’accomplit de fagon automatique par Microsoft
Windows 98/2000/Me. Apres avoir relié I’interface USB sur un port de

communication libre, le systeme d’exploitation effectue la lecture et la détection du
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périphérique USB. Une boite de dialogue, celle ci-dessous, vous informera sur la

détection de I’interface USB au premier branchement.

Assistant Ajout de nouveau matériel

Cet Azsistant recherche de nouveaus pilotes pour

USE <-» Serial

Un pilote de pérphéngue est un logiciel qui permet & un
peniphénique maténiel de fonctionner.

< Precedent |& Suivants Arnwler

Cette boite de dialogue vous informera que I’interface Pci4-USB vient d’étre
détecté par

Windows.

Assistant Ajout de nouveau matérniel

[ue voulez-vous faire 7

Fechercher le meilleur pilate pour votre
penphéngue, [Fecommands].

Afficher une liste de tous les pilates situés dans un
emplacement précis, afin de pouvair installer le
pilate de votre choix.

< Précédent | Suivant> Annuler

En cliquant sur suivant, il vous sera demandé¢ de spécifier I’emplacement du
gestionnaire de périphérique. La seconde option vous permettra de spécifier le

‘Driver’ selon un emplacement spécifique.



Assistant Ajout de nouveau matériel
Windows va rechercher des nouveaus pilotes dans za
base de données. sur votre disque dur et dans les endroits

zélectionnés. Cliquez sur Suivant pour commencer la
recherche.

[T Lecteurs de disquettes
I~ Lecteur de CO-ROM
™ Microsoft Windows Update

¥ Définir un emplacement :

IE: Sl D OS5 Bureauth D river] j

Parcourir... |
<Elécédent| Suivant > I Anruler |

Les pilotes ‘Driver’ pour la carte Pci4-USB se retrouve dans le dossier E:\PCI4-
USB\DRIVER\ ou ‘E:\’ représente la lettre de votre lecteur CD-ROM.

Le systeme d’exploitation vous confirmera par le message ci-dessous que les
pilotes correspondant a la carte Pci4-USB sont conformes pour le type de

périphérique détecté.

Assistant Ajout de nouveau matériel
Windows recherche les fichiers du pilote pour ce
périphénque :

USE High Speed Sernial Converter

Windows £'appréte maintenant a installer le meillzur pilote
pour ce pénphéngue. Cliquez sur Précédent powr choisir
un autre pilote, ou sur Suivant pour poursuivie,
Emplacement du périphérique :

CAWIND WS ABUREAUNDRIVERAFTDIELS
=

< Précédent | Suivant> Annuler




Une fois I’installation des pilotes effectués, un dernier message confirmera que
I’interface ‘USB High Speed Serial Convertor’ est maintenant présent sur le

systeme.

Aszsistant Ajout de nouveau matériel

3 USE Serial Port

WWindows a terming l'installation du logiciel néceszaire &
volre nouveau pénphénque matériel,

< Frecedent | Teminer Annuler |

La derni¢re étape consiste a effectuer I’installation du ‘USB Serial Port’ en suivant
les mémes étapes expliquées ci-dessus. Un dernier message vous

confirmera de nouveau que le pilote est chargé et présent sur le systeme.

Aszzizstant Ajout de nouveau maténel

% USE High Speed Sernial Corverter

Windows & teming installation du logiciel néceszaire &
volre nouveau perphéngue mateériel.

i Teminer Annuler

< Erecedent

La vérification de I’installation peut se faire avec un clique-droit sur 1’icone du

bureau ‘Poste de travail’ et en sélectionnant propriétés.



Propriétés Spstéme EE
Général Gestionnaire de perphériques | Frofilz matérielsl Petformancesl

% Afficher les périphéngues par lpe ¢ Afficher les périphérigues par connexion

B F2 Clavier |

E| Q Contréleurs de busz USE

Concentrateur USE racine
Contrdleur d'hate PCI vers USE universel Intel 82371AB/EB
R USE High Speed Serial Converter
I % Contrdleurs de dizgque dur
#-52 Contrdleurs de disquette
@ Ecrans
- =0 Lecteurs de disque
Périphénques swstéme
= 5 Ports [COM et LPT]
F Port de communication [COMT)
éy‘ Port de communication [COM2)
“_bi Port imprimante [LPT1)

RS § I"E Ccricl Port [COM 3

E’D Souris =i
-

Propriétés | Actualizer Supprimer | Imprimer... |

Les propriétés systémes, figure ci-dessous, vous informeront sur le périphérique
détecté par le systeéme d’exploitation. Les deux éléments ‘USB High Speed Serial
Convertor et USB Serial Port’ confirme I’installation de I’Interface Pci4-USB sur

le systeme.

2) Installation des librairies ‘DLL et ActiveX’

-DLL

La librairie ‘Dynamic Link Library’ pour la carte Pci4-USB se retrouve dans le
dossier E:\PCI4-USB\DLL\ ou ‘E:\’ représente la lettre de votre lecteur CD-ROM.
La librairie ‘DLL’ ne demande pas une installation particuliere, donc elle doit €tre

mise dans le répertoire du programme ou du projet en cours d’utilisation.



Pour désinstaller la librairie ‘DLL’, I'utilisateur doit supprimer le fichier pci4.dll
du projet. Aucune modification de la base de registre ou création de fichier survient
lors de I’installation de la librairie. En somme, la suppression de la librairie pci4.dl!

conclut la désinstallation.

- ActiveX

La librairie ‘ActiveX’ pour la carte Pci4-USB se retrouve dans le dossier E:\PCI4-
USB\OCX\ ou ‘E:\’ représente la lettre de votre lecteur CD-ROM. L’installation
automatique s’effectue en exécutant le fichier installOcx.bat. Ce fichier permet la
copie du composant ActiveX vers le répertoire SYSTEM de Microsoft Windows,
¢galement il enregistre le composant aupres de Windows a I’aide de la commande

regsvr32.exe.

La seconde méthode consiste a copier manuellement le fichier pcidusb.ocx vers le
répertoire SYSTEM de Windows. Par la suite, il faut exécuter la commande

regsvr32.exe pcidusb.ocx pour compléter I’enregistrement du composant ActiveX.

En exécutant la commande regsvr32.exe —u pcidusb.ocx il est possible d’enlever
I’enregistrement du composant ActiveX. Egalement, le composant doit étre
supprimé du répertoire SYSTEM de Windows : Fichier pcidusb.ocx et pcidusb.oca
. La méme opération peut €tre automatisée en exécutant le fichier uninstallOcx.bat
présent dans le répertoire E:\PCI4-USB\OCX\ ou ‘E:\’ représente la lettre de votre
lecteur CD-ROM.

Procédure d’opération

L’interface de test en C++ et en Visual Basic permet de tester les principales

fonctions de la carte.



Interface de test en C++

= PCI4-USB
Iritialization  Aide

—En Binaire

S [=] 3

Lectures:

I'I'I'I'I'I'I'I'
23 45 67

I'I'I'I'I'I'I'I'
B 9 10 111213 14 15
I I B
16 17 18 19 20 21 22 23

E criture:

I'I'I'I'I'I'I'I'
23 45 67

I'I'I'I'I'I'I'I'
8 910 11 1213 14 15
oo
1617 1819 20 21 22 23

—Par Registre Forction Démo K2000——
|D ID [~ Start/Stop
|D IEI E crit I
|D IEI Cuitter

Menu de I’interface :
Le menu Initialisation vous permet d’initialiser la carte. Normalement,
I’Initialisation est effectuée lors du chargement de 1’interface usager. Si la carte n’a

pas ¢été préalablement Initialiser, vous pouvez utiliser le sous-menu Initcarte.

Le menu aide vous permet de consulter la fenétre A Propos qui vous renseignera

sur les concepteurs de I’interface, du numéro de version, etc.

Deux sections vous sont offertes, la section En Binaire et la section Par Registre.
La section En Binaire est répartie en deux groupes, le groupe de lectures et le
groupe d’écritures. Le groupe de lecture permet de lire tous les ports bits par bits.
Cette lecture se fait automatiquement grace au temporisateur de lecture. La section
Ecriture permet de changer 1’état de n’importe quel bit en cliquant sur la case a

cocher représentant ce bit.

La section Par registrer vous permet de voir I’état de vos ports en décimal. Il vous

permet aussi d’écrire une valeur directement sur un port. Pour ce faire, des boites
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d’¢éditions vous permet d’écrire la valeur a écrire sur les ports 0, 1 et 2. Apres avoir
remplis les boites d’éditions, vous n’avez qu’a appuyer sur le bouton Ecrit pour
envoyer la valeur sur la carte PCI4-Usb.

La derniére section de 1’application est la fonction de démonstration K2000. La
fonction K2000 vous permet de faire une démonstration de la carte PCI4-Usb et de
tester le bon fonctionnement des écritures sur la carte. La fonction de
démonstration se démarre en cochant la case a cocher Start/Stop. La fonction

arrétera lorsque vous décocherez la case a cocher Start/Stop.

Interface de test Visual Basic :

. Interface de test pour carte USB _ O] x|

— Lecture

f B B 4 3 2 1 1D

Pt 9 900999 Q@@
Pl @ 00099 @@
it @ 00999 @@

— E criture D étection |
Fota [ T CC

PetB OO
FotC [~ I I I T I Ecrire port

llﬂﬂ.ﬂ,

K2000 |

Lire port |

| o R | R
Lecture Guitter

L’interface de test Visual Basic fonctionne de la méme fagon que I’interface de test
en C++. Le bouton de détection vous permettra de détecter la carte. Un message
apparaitra dans la boite de texte est vous indiquera si la carte a été détectée ou non.
Le panneau Lecture vous indiquera 1’état de chacun des bits des trois ports. Pour
pouvoir visualiser I’état de chacun des bits, il faut appuyer sur le bouton Lecture.
Le panneau Ecriture vous permet d’affecter I’état de n’importe quel bit en cochant
ou décochant la case correspondante au bit que vous voulez affecter. Le bouton
Lire Port vous permet de lire un port spécifique. Vous pouvez choisir le port que

vous voulez lire en utilisant les boutons RO, R1 et R2. Le résultat de cette lecture
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sera afficher dans la boite de texte dans le coin supérieur droit de I’application. De
plus le bouton EcrirePort vous permet d’écrire la valeur 0xAA sur le port de votre
choix que vous pouvez sélectionner en utilisant les boutons RO, R1 ou R2. Une
confirmation de cette écriture apparaitra dans la boite de texte.

Exemple d’utilisation :

Si vous désire tester votre carte PCI4 Usb, voici quelques étapes d’utilisation de

I’interface de test en Visual Basic et en C++.

Premiérement, vous devez détecter votre carte.

En C++ : La détection se fera automatiquement lorsque vous lancerez
I’application. Un message vous indiquera si la détection a réussi. Si la détection a
échoug, utiliser le sous-menu InitCarte du menu d’Initialisation. Si aprés quelques
essais, la carte n’est pas détectée, référez-vous a la section d’installation de ce

manuel.

En Visual Basic : Vous devez appuyer sur le bouton Détection pour lancer la
détection de la carte. Un message apparaitra dans la zone de texte et vous indiquera
si la détection a réussi ou non. Si la carte n’a pas été détectée, réappuyez sur le
bouton Détection. Référez-vous a la section d’installation de ce manuel en cas de
probléme de détection. Lorsque votre carte sera détectée, vous pouvez utiliser les

possibilités de I’interface de test.

Exemple d’écriture sur un bit :

Pour écrire sur un bit, il suffit de cocher ou décocher la case du bit que vous voulez
écrire. En C++ et en Visual Basic, le panneau Ecriture vous permet d’effectuer
cette action.

Exemple : En C++ et en Visual Basic, coché la case du bit 8§ du panneau écriture.
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Exemple de lecture d’un bit :

Pour I’état d’un bit : En C++ : La lecture se fera automatiquement et vous devriez
voir I’état du bit 8§ modifié précédemment dans le panneau

Lecture.

En Visual Basic : Appuyer sur le bouton Lecture pour mettre a
jours I’affichage de I’application. Vous devriez voir changer

I’¢état du bit 8 modifié précédemment.

Pour écrire une valeur sur un port :

En C++ : Dans la section Par port, entrer votre valeur dans la
boite d’édition correspondant au port désiré. Appuyer sur le
bouton écrit. Il est important de mentionner que les trois boites
d’éditions sont envoyées vers les ports. Si vous ne désirez pas
qu’un port soit affecté, mettez la valeur présente de ce port

dans la boite d’édition avant d’appuyer sur le bouton Ecrit.

En Visual Basic : Sélectionner le port voulu en utilisant les
boutons RO, R1 et R2. Appuyer sur le bouton Ecrire Port. La

valeur OxAA sera écrite sur le port choisi.

Pour lire une valeur sur un port :

En C++ : La lecture se fait automatiquement. Vous n’avez
qu’a vérifié les boites a cocher du panneau lecture ou les boites
du groupe par port. Ils vous indiqueront les valeurs de chacun

des ports.
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En Visual Basic : Sélectionner le port voulu en utilisant les
boutons RO, R1 et R2. Appuyer sur le bouton Lire Port. La

valeur du port qui a été lu sera affichée dans la boite d’édition.

Contenu matériel de I’interface Pci4-USB

L’interface Pci4-USB se divise en deux circuits. Le premier circuit ¢tant le
convertisseur USB <-> Série et le second, la carte d’entrée/sortie avec le
microcontroleur PIC. Une description pour chaque circuit est disponible ci-
dessous. Egalement, le dernier paragraphe de cette section explique I’interrelation
entre les deux cartes : Carte convertisseur USB et Microcontrdleur PIC avec 24

entrées/sorties.

- Convertisseur USB

La premicre carte, celle illustré ci-dessous permet la conversion du protocole USB

vers le protocole série RS232.

Le cceur de cette carte consiste en un circuit intégré provenant de la compagnie
FTDI. Ce circuit intégré, le FT8U232AM, initialise la communication avec
I’ordinateur hote en envoyant les descripteurs nécessaires pour configurer la
connexion de I’Interface USB vers le PC. Son role est d’effectuer la détection de la

carte aupres du systéme d’exploitation et de controler les trames et protocole USB
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pour les convertir en un format standard au RS232. Un schéma électrique en
annexe ou sur le CD-ROM ‘E:\SCHEMA\USB’ son disponible pour illustrer en

détail le fonctionnement du circuit

La premiere section du convertisseur USB <-> Série est la liaison des lignes de
communications différentielles ‘D+/D-’. Chaque ligne ont une impédance créé par
les résistances R12 et R14. La valeur de ces résistances est spécifiée par les
standard USB disponible a I’adresse www.usb.org ou sur le document usbStd.pdf
présent dans le répertoire E:\DOC\ . Egalement, la résistance R4 de type PULL-
DOWN présente sur la ligne ‘D-’ fixe la communication USB a un débit de 1.2
MB/s pour le mode LOW-SPEED.

Une seconde partie trés importante du convertisseur USB <-> Série est la mémoire
série de type Microwire connecté sur le circuit spécialisé. Son but est de
personnaliser le descripteur du périphérique USB. Il est possible de programmer
directement cette Eeprom en circuit par I'utilitaire E2Prog . L’utilitaire se retrouve

sur le site du fabriquant www.ftdi.co.uk et dans le répertoire EX\\UTILS\EEPROM\ .

Cependant, le projet existant n’utilise pas cette fonction pour personnaliser le
descripteur de I’Interface Pci4-USB. L’interface graphique ci-dessous provient de

I’utilitaire en question.
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= EZ2PROG for FTBU232 -0 x|

File Device Help

OB B2 9

b arufacturer |T. .0 M anufacturer 1D |11

Wendor |0 |:|.234
Froduct [D Il:ll:ll:l:L

Description |P|:'i 4-USE 1.00

=

|MODE: Program

En somme, un descripteur par défaut est chargé si le descripteur présent en Eeprom
est invalide ou si I’Eeprom est manquant du circuit. Donc, le circuit est
présentement configuré pour utiliser le descripteur par défaut puisque la mémoire

Eeprom ne contient présentement pas de descripteur spécifique ou personnaliser.

Le connecteur présent sur la carte permet d’inter relier le convertisseur USB <->
Série vers I’interface des entrées/sorties. Le connecteur se compose principalement
de 10 broches reliées directement vers les entrées/sorties du circuit FT§U232AM.
La fonction de chaque broche est décrite ci-dessous dans le tableau. Toutes les

broches sont utilisées par des signaux de type RS232 ‘“+5v/0v’ et I’alimentation du

circuit.
Position Nom
1 TXD
2 RXD
3 RTS
4 CTS
5 DTR
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6 DSR

7 DCD

8 SLEEP
9 Vee

10 Gnd

Tous les signaux disponibles sur le connecteur au format RS232 ne sont pas
différentiels. Donc, leur tension est de type logique 5v =1 et Ov = 0. Egalement des
diodes électroluminescentes ‘LED’ permettent la visualisation des changements sur

les lignes TX et RX.

- Interface microcontroleur

Le microcontrdleur utilisé pour interfacer les 24 entrées/sorties et la carte de
conversion USB provient de la compagnie Microchip. Le microcontroleur
PIC16c64a, illustrer ci-dessous possede 1’architecture Harvard et peut contenir
jusqu’a 2K de code en Eprom. Le modele utilisé dans le projet de I’interface USB
est effacable par une lampe a I’ultra violet, par ajout des ‘One Time Programable’

devront étre utilisé pour la production puisqu’il ne sont pas dispendieux.
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MCLRVPp —= [
R0 == [

Rl e [

FAZ == ]

Rag = [

Rt (T e []
RAGES =i [
REQRD == ]
RE1/WR - [
REZTS 4w [

VDD — [

Vas —= [
DECUCLEIN —- [
OSCACLKOUT -=+—
ROOT10SOTICH ~—m= [
ROUTI0S| = [
RCZICCRT == [
ROMSCKISCL =+ [
ROOPEPD - [

ROVPSP1 == [

08 =] O £ &= L R =

4]

10
11
12
13
14
15
16
17
L]
19
20

.

33
38
a7
3G
35
k=)
33
32
3
30
24
28
27
26
25
24
23
22
21

[ ] - RBT

[ ] == RBEG

[ ] == RB5

[1 - FB4

[ ] == RE3

[] -+ RBZ

[ ] - RR1

[ ] = REOINT
] -— von

[] -— =5

[ ] = QO7PSPT
[ ] - RDEPSPG
[ ] - RDSPSPS
[ == RD4FPSPY
[ - g7

[ - RiE

[] == RCSS00
| ] - RCASDISDA
[ ] - RD3PSPS

[] == ROZPSPZ

PIC16C64A

microcontroleur PIC.

La tache du microcontroleur PIC est d’interpréter les commandes regus par les
lignes de communication série selon un protocole expliqué dans la partie logiciel.
Apres avoir traduit les commandes et les données transmises par le convertisseur
USB, il modifiera ou lira I’état des 3 ports 8 bits pour controler les 24

entrées/sorties. Le tableau ci-dessous affiche 1’assignation des ports 0-2 sur le

Nom Connexion sur PIC
Port 0 RBO0-RB7
Port 1 RCO0-RC7
Port 2 RDO-RD7
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Les 24 entrées/sorties sont capables de délivrer une intensité ‘Ampere’ suffisante
pour alimenter directement une del ‘LED’ ou une entrée de type CMOS/TTL.
Cependant, une suralimentation ou une décharge statique sur 1’une des 24 lignes

pourrait détruire le microcontroleur. C’est pourquoi il est conseillé d’utiliser un




¢tage de type ‘buffer’ ou ‘opto coupleur’ pour protéger le microcontroleur des

accidents pouvant subvenir sur les lignes.

Une partie du circuit permet I’observation de 1’état de chaques entrées/sorties avec
I’aide de del ‘LED’. Les 24 dels ‘LED’ présentes sur le circuit, image ci-dessous,
affichent I’état des lignes. Egalement, il est possible de changer 1’état des entrées
en déplagant la position des interrupteurs S4-S6. Les interrupteurs S1-S3 sont

utilisés pour I’activation ou la désactivation d’un port ou d’un bit en particulier.

-
-
-
1.
]
-
-
-
-
-
o |
¥a
L]
-
-
-_
-
-
-
%1
-
-y
L]
-

L’alimentation de la carte Pci4-USB, image ci-dessous, est fournie principalement
par un bloc d’alimentation qui est raccordé¢ sur le connecteur P7. La tension doit
obligatoirement se situer en 6v et 9v avant d’entrer dans le régulateur ‘7805 qui
fixera la tension a Sv. Une diode D1 évite les inversions
m sur I’alimentation et protege le régulateur. Finalement,

un filtrage est effectué par les condensateurs C1-3 avant et apres le régulateur.

Le circuit de reset, image ci-dessous, force I’entrée MCLR ‘pin 1’ a 0 pour
réinitialiser le microcontrdleur. Egalement, le micro interrupteur

S7 force ’entrée MCLR a 0 et le circuit RC assure un délais

suffisant pour effectuer un reset complet.
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Pour conclure sur la section de 1’interface microcontroleur, le fonctionnement reste
briévement simple puisque le microcontroleur gére le fonctionnement de toutes les
entrées/sorties présentent sur la carte. Seul le circuit de visualisation,
d’alimentation et de reset sont ajouté pour complémenter le fonctionnement de la

carte.
*Pour de plus amples renseignements sur le microcontréleur, la fiche technique du
PIC16c64a ‘picl6c64.pdf’ est disponible sur le CD-ROM dans le répertoire

E:\DOC\PIC.

Interrelation entre les cartes

Le circuit imprimé du convertisseur USB et de I’interface avec microcontrdleur
PIC s’assemble via le connecteur série *10 broches’, celui encadré par le rectangle,
pour compléter I’interface Pci4-USB. Le résultat de 1’assemblage est illustré ci-

dessous.
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Pour faciliter I'acces aux entrées/sorties, des borniers sont accessibles sur le c6té du
circuit imprimé. Chaque borniers sont reli¢ au Port 0-2. Egalement, une broche du

connecteur permet d'utiliser la masse du circuit.

Le tableau ci-dessous représente le brochage des connecteurs disponibles sur le

cOté.

Position Nom

[E—

Bit 0

Bit 1

Bit 2

Bit 3

Bit 4

Bit 5

Bit 6

Bit 7

O 0| Q| O] | K|l W]

Gnd ‘Masse’

Les trois ports de 8 Bits sont disponibles sous un seul connecteur. Le connecteur de
48 broches situé au bout du circuit permet l'utilisation d'un cable nappe pour
interconnecter l'interface pci4-USB sur un projet. Tous les bits présent sur le
connecteur possede une masse pour interfacer les bits séparément et permettre une

réduction des parasites sur la communication.

Le tableau ci-dessous identifie tous les bits présent sur le connecteur 48 broches

situés au bout de la carte d’interface.
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Position Nom
1 Bit 0
2 Gnd
47 Bit 23
48 Gnd

- Ajustement interne de la carte

La carte pci4-USB possede en tous 3 cavaliers configurables par le technicien. Ces
trois cavaliers servent principalement a configurer le type d’alimentation et la

vitesse du cristal. L’image ci-dessous illustre les trois cavaliers présent sur la carte.

Les cavaliers 1 et 2 ont la possibilité¢ d’étre mis selon deux positions:[--]-- ou --[--]
ou le symbole -’ représente la broche et ‘[]” le cavalier. Cependant, le troisiéme
connecteur ne possede pas de position. Il peut €tre retiré ou posé pour spécifier le
type d’alimentation. Pour clarifier les configurations possibles, le tableau ci-

dessous explique les fonctions disponibles.
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Cavalier 1

Options Fonction
Gauche [--]-- Cristal de 48 MHz utilis¢ ‘Multiplicateur interne
inactif’
Droite --[--] Cristal de 6 MHz utilisé ‘Multiplicateur interne actif’
Cavalier 2
Options Fonction
Gauche [--]-- Alimentation du convertisseur série fournit par le
cable USB
Droite --[--] Alimentation du convertisseur série fournit par la carte
microcontroleur
Cavalier 3
Options Fonction
Fermé [--] Alimentation du convertisseur série fournit par la carte

microcontroleur

Ouvert --

Alimentation du convertisseur série fournit par le
cable USB ‘Ne nécessite pas ’alimentation de la

carte’

En somme, le cavalier 2 et 3 sont utilisés conjointement pour spécifier le type

d’alimentation. Si 1’utilisateur décide d’alimenter sa carte USB a 1’aide du bloc

d’alimentation et non par le cable USB, le cavalier 2 doit étre a droite et le cavalier

3 est fermé pour alimenter le convertisseur USB.

Avec I’aide des cavaliers il serait possible d’auto alimenter la carte pci4-USB par

le port USB, mais une limitation de 500 mA s’impose. Donc, il est fortement
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conseillé d’utiliser une alimentation externe provenant d’un bloc d’alimentation.
L’intensité ‘Ampére’ fournit par le cable USB est insuffisant pour le
fonctionnement de la carte USB di aux nombreuses DEL ‘Led’ utilisées pour

visualiser les changements sur les bits.

- Banc de test

Les tests effectués en laboratoire sont surtout sur la carte convertisseur série et la
carte microcontroleur PIC. La premicre carte, carte USB, peut étre testée
simplement en utilisant un cavalier qui sera connecté sur la broche 1 et 2 du bornier
de 10 broches présent sur la carte. En inter reliant ces deux broches un NULL-
MODEM est créé a partir de I’interface USB. Donc, il est possible d’utiliser un
programme de communication ‘ex : Hyperterminal® ou le programme terminal
présent sur le CD-ROM dans le répertoire EAUTILS\TERMINALN\ pour
communiquer directement avec la carte USB. Un test fonctionnel devrait retourner

correctement tous les caracteéres envoyés par I’utilisateur.

En cas d’erreur le fichier debug.pdf présent dans le dossier E:\DOC\FTDI\ peut
étre utilisé pour dépanner le circuit du convertisseur USB. Egalement, des
modifications sur le schéma ¢€lectrique sont effectuées en tout temps par la

compagnie FTDI. Donc, il est conseillé de visiter le site Interner www.ftdi.co.uk

pour obtenir les dernieres informations et mise a jour du circuit.

Les tests matériels sur I’interface microcontréleur PIC sont restreints. La premiere
¢tape consiste a vérifier si I’alimentation est présente sur les broches du
microcontrdleur PIC. La seconde est d’effectuer un test a I’aide d’un cable série
RS232 ‘COM1 ou COM?2’ et de gérer le protocole de communication
manuellement a I’aide d’un logiciel de terminal. Cependant, pour effectuer un test
de communication RS232 un convertisseur de tensions +12v est exigé. En

laboratoire, un circuit spécialisé le MAX233 semblable au MAX232 a été utilisé
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pour réaliser I’interface de test. En somme, les tests présentés ci-dessus permettent

d’isoler les problémes pouvant subvenir.

Contenu logiciel du projet

Fonction de la DLL

OnTimer:

Cette méthode est appelée par I’événement OnTimer du temporisateur. Cette
fonction permet de sortir le PC de sa boucle d’attente lorsque que la carte ne
répond pas.

TestDevice:

Cette méthode détecte la présence de la carte et sur quel COM virtuel il faut lui
envoyer les données. Retournera 1’état logique vrai si la carte est détectée ou 1’¢tat
logique faux si elle n’est pas détectée.

OnRxChar:

Cette méthode est appelée par I’événement OnRxChar lorsque le composant série

recoit un caractére. On indiquera alors qu’une donnée a été recue.

OnTxEmpty:

Cette méthode est appelée par I’événement OnTxEmpty lorsque le tampon de
transmission est vide. Cette méthode sert a la validation des commandes et des

données par la ligne de controle DTR. Des problémes ont été remarqués lors de
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I’implémentation, car le driver FTDI du convertisseur USB a SERIE ne semble pas

géré correctement cet événement. TXEmpty

TxDonnee(char cCar):

Cette méthode est utilisée pour envoyer une donnée vers la carte PCI4 Usb. Cette
méthode a été utilisée en remplacement de la validation des commandes et données
via la ligne de controle DTR. Le but de cette méthode est de s’assurer que I’on a
bien transmit une commande avant de transmettre la donnée.

TxCommande(char cCar):

Cette méthode est utilisée pour envoyer une commande vers la carte PCI4 Usb.
Cette méthode a été utilisée en remplacement de la validation des commandes et
données via la ligne de controle DTR. Le but de cette méthode est de s’assurer que
I’on peut transmettre la commande afin d’éviter quel soit pris pour une donnée.

bit set(int bit):

Permet de mettre le bit spécifié sur la carte PCI4 Usb a un.

bit_clear(int bit):

Permet de mettre le bit spécifié sur la carte PCI4 Usb a zéro.

int lire _bit(int bit):

Permet de lire un bit spécifié sur la carte PCI4 Usb. On retournera I’état (0 ou 1) du

bit.
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ecrire_bit(int bit, int etat):

Permet de mettre le bit spécifié selon 1’état spécifié. Les états possibles sont 0 ou 1.

Cette méthode utilisera les méthodes bit_set et bit_clear.

unsigned int lire RO:

Permet de lire le Port0, soit les bits 0 a 7 de la carte PCI4 Usb.

unsigned int lire R1(void):

Permet de lire le Portl, soit les bits 8 a 15 de la carte PCI4 Usb.

unsigned int lire R2:

Permet de lire le Port2, soit les bits 16 a 23 de la carte PCI4 Usb.

ecrire_ RO(int nPort):

Permet d’écrire sur le Port0, soit sur les bits 0 a 7 de la carte PCI4 Usb.

ecrire_R1(int nPort):

Permet d’écrire sur le Portl, soit sur les bits 8 a 15 de la carte PCI4 Usb.

ecrire_R2(int nPort):

Permet d’écrire sur le Port2, soit sur les bits 16 a 23 de la carte PCI4 Usb.
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Fonction de ’interface C++

FormActivate:

Lors de I’ouverture de I’application de test, la fonction FormActivate est appelée.
Cette fonction aura pour but de détecter la carte PCI4 Usb et de démarrer le
temporisateur de lecture de la carte.

Timer1Timer:

Cette méthode sera appelée par le temporisateur de lecture sur un OnTimer. Dans
cette méthode, on lira les trois ports de la carte et on affichera les valeurs dans les
cases prévues a cet effet et dans les cases a cocher de la section lecture.
Chkwbit2Click:

Cette méthode sera appelée lorsque que I’on click dans une case a cocher du
groupe d’écriture. On écrira ensuite la valeur sur la carte PCI4 Usb en utilisant la
propriété bit.

btnEcritClick:

Cette méthode sera appelée par le bouton Ecrit. Il permettra d’écrire sur la carte

PCI4 Usb les valeurs contenues dans les boites d’édition.

mnulnitClick:
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Cette méthode est appelée par le menu InitCarte de 1’application et permet de

détecter la carte. Cette méthode appellera la fonction FromActivate.

mnuAProposClick:

Cette méthode permet de voir la fenétre A Propos qui donne quelques informations

sur I’application de test.

ChkStartClick :

Cette méthode permet de démarrer la fonction K2000. Cette méthode est une

méthode créer pour la démonstration du fonctionnement de la carte.

tmrK2000Timer:

Cette méthode est appelée par le tmrK2000 lors de 1’événement OnTimer. Cette
méthode décale un bit de gauche a droite ou de droite a gauche. Cette méthode est

une méthode créée pour la démonstration du fonctionnement de la carte.

btnQuitterClick:

Cette méthode vous permet de quitter 1’application.

- Description des événements interceptés

OnTimer:

a) Programme de test:

1- L’événement OnTimer du temporisateur tmrTimer utilisé pour effectuer

une lecture a un temps donnée.
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2- L’événement OnTimer du temporisateur tmrK2000 utilisé pour un
décalage de bit a un intervalle précis.

b) DLL:
L’événement du tmrTimer est utilisé dans deux situations:
1- Lors de la détection I’événement OnTimer permettra d’indiquer que le
temps de réponses est terminé.
2- Lors d’une lecture, I’événement OnTimer sortira le PC de sa boucle

d’attente une trop longue attente.

OnClick

a)Chkwbit2Click

Evénement OnClick des cases a cocher. Cet événement servira a écrire I’état d’un

bit dont le numéro est contenu dans le tag de la case a cocher.

b) btnEcritClick

Evénement OnClick du bouton qui permet d’écrire sur la carte PCI4 Usb les

valeurs contenues dans les boites d’éditions.

¢) mnulnitClick

Evénement OnClick du sous-menu Init. Permet d’initialiser la carte PCI4 Usb

d) mnuAProposClick.

Evénement OnClick du sous-menu A Propos. Permet de voir la fenétre A Propos.

e) chkStartClick
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Evénement OnClick de démarrer ou d’arréter la fonction K2000 .

f) btnQuitterClick

Evénement OnClick permettant de fermer 1’application de test.

OnRxChar:

L’événement OnRxChar du composant série de la DLL permet de recevoir des
caracteres du port série.

OnTxEmpty

L’événement OnTxEmpty nous indique que le tampon de transmission du

composant série est vide.

- Donnée membre stratégique

- DLL

char cRegRO : Contiendra la derniére valeur lue du port 0.
char cRegR1: Contiendra la derniéere valeur lue du port 1.

char cRegR2: Contiendra la derniére valeur lue du port 2.

int m_nCommande: Indiquera si I’on doit transmettre une donnée ou une
commande a zéro, elle indiquera que I’on peut transmettre une
commande a un elle indiquera que I’on peut transmettre une

donnée

int m_nFlag: Indiquera s’il y a eu détection de la carte.

A zéro, elle indiquera que la carte n’a pas été détectée.
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A un, elle indiquera que la carte a été détectée.

int m_nDataReady: Indiquera qu'une donnée a été regue a zéro, elle indiquera

int m_nTimeOut:

qu’aucune donnée n’a été regue a un, elle indiquera qu’une

donnée est disponible.

Indique que le délai permis pour une réception est dépassé

A zéro, elle indiquera que le temps d’attente n’est pas dépassé

a un, elle indiquera que le temps d’attente est dépassé.

- Programme de test

int m_nBit :

int m_nDir:

Numéro du bit ou I’on est rendu pour la fonction K2000

Direction, droite ou gauche pour la fonction K2000

A zéro, elle indiquera que 1’on va a droite.

A un, elle indiquera que I’on va a gauche.

- Index des fonctions utilisés

Nom de la fonction

Ficher contenant le code

Fichier contenant les prototypes

FormActivate fpcid.cpp fpci4.h
Timer1Timer fpci4.cpp fpci4.h
Chkwbit2Click fpci4.cpp fpci4.h
btnEcritClick fpci4.cpp fpci4.h :
mnulnitClick fpcid.cpp fpci4.h
mnuAProposClick fpci4.cpp fpci4.h
chkStartClick fpci4.cpp fpci4.h
tmrK2000Timer fpcid.cpp fpci4.h
btnQuitterClick fpcid.cpp fpci4.h
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OnTimer pciddll.cpp pci4dlLh
TestDevice: pciddll.cpp pci4dll.h
OnRxChar: pciddll.cpp pci4dll.h
OnTxEmpty: pciddll.cpp pci4dll.h
TxDonnee(char cCar): pciddll.cpp pci4dll.h
TxCommande(char cCar): pciddll.cpp pci4dlLh
bit_set(int bit): pci4dll.cpp pci4dll.h
bit clear(int bit): pciddll.cpp pci4dll.h
int lire_bit(int bit): pci4dll.cpp pci4dll.h
ecrire_bit(int bit, int etat): pciddll.cpp pci4dll.h
unsigned int lire R1(void): pciddll.cpp pci4dllLh
unsigned int lire R2: pciddll.cpp pci4dll.h
ecrire_RO(int nPort): pci4dll.cpp pci4dll.h
ecrire_R1(int nPort): pciddll.cpp pci4dllLh
ecrire_R2(int nPort): pciddll.cpp pci4dllLh
- Diagramme de classe
Interface de test CPCI3

H

CPCI3 : Classe principale de la DLL Pci3dll gérant la carte PCI4-Usb.

Fonction du composant ActiveX

- Composant ActiveX
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Le logiciel Microsoft Visual Basic a été utilisé pour la création du composant
ActiveX pcidusb. Ce composant est utilisable dans les logiciels de développement
tel que Microsoft Visual Basic, Borland C++ Builder et Delphi. Le code source de
ce composant est disponible sur le CD-ROM dans le répertoire E:\CODE\OCX\ ou
E:\ représente la lettre de votre lecteur CD-ROM.

Le fonctionnement de chaque fonction est décrit par les ordinogrammes situés en
annexe et ci-dessous. Egalement, le diagramme de classe ci-dessous illustre
I’implémentation du composant ActiveX dans un projet. Le projet utilisé pour
contrdler ’interface Pci4-USB consiste en un programme de test qui effectue des

opérations sur les entrées/sorties.

Programme de test P Composant ActiveX

- Description des fonctions et méthodes

Lire_Port(nPort As Integer) As Byte

Cette fonction effectue la lecture du Port 0-2 en envoyant Ox4a selon le protocole
¢tabli pour la communication. Le parametre nPort doit contenir le numéro du port,
soit : 0,1,2. La fonction transmettra la fonction ainsi que la commande avant de
recevoir le résultat. Le résultat de la lecture sera retourné dans la variable

Lire_Port sous un byte.

Ecrire Port(nPort As Integer, nData As Integer)

La fonction Ecrire Port permet 1’€criture d’un byte sur le Port 0-2. Le paramétre
nPort doit contenir le numéro du port, soit : 0,1,2 et le paramétre nData contient la

valeur qui sera écrite directement sur le port du microcontréleur. Cette fonction
34



utilise la commande 0x5a pour transmettre une donnée. Le numéro du port est
ajouté au numéro de la fonction pour spécifier le port choisi, par exemple : Port 0 =

0x5a, Port 1 = 0x5b, Port 2 = 0x5c.

Bit_Set(nBit As Integer)

Le positionnement d’un bit est effectué en utilisant la fonction Bit Set. Le numéro
du bit est spécifi¢ par le parameétre nBit qui doit étre compris entre 0-23. Donc,
pour activer le bit 0 du Port 1 il faut mettre nBif a 8. La fonction 0x2a est utilisé

pour spécifier le nom de la fonction au microcontrdleur.

Bit_Clear(nBit As Integer)

Le positionnement d’un bit est effectu¢ en utilisant la fonction Bit Clear. Le
numéro du bit est spécifié¢ par le parametre nBit qui doit étre compris entre 0-23.
Donc, pour désactiver le bit 0 du Port 2 il faut mettre nBit a 16. La fonction 0x3a

est utilisé pour spécifier le nom de la fonction au microcontroleur.

Init_Usb() As Boolean

Une détection de I’Interface Pci4-USB est réalisée en utilisant la fonction /nit Usb.
Cette fonction retournera true si I’interface Pci4-USB est connectée sur le port
USB de I’ordinateur. La fonction effectue une recherche de I’interface en envoyant
la commande 0x0a. Par la suite, une lecture est effectuée pour vérifier si la capture
donne Oxab. Le code Oxab retourné par le microcontrdleur spécifie si I’interface est
bien connectée et présente sur I’ordinateur. En somme, cette fonction permet de
déterminer si une interface de communication pci4-USB est présentement connecté

et prét a communiquer. Le résultat sera faux si I’interface est inactive.

Stop_Usb()
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Cette fonction permet la fermeture du port de communication avec I’interface pci4-
USB. En appelant cette procédure, la communication sera coupé instantanément.
Egalement, cette procédure est appelé a la destruction du composant ActiveX.
L’utilisateur n’est pas obligé de faire appel a cette procédure, car son appel est fait

durant fermeture du composant ActiveX.

- Index des fonctions

Fonction Fichier source

Public Function Lire Port(nPort As Integer) | Objet ActiveX usrUsb ‘usrUsb.ctl’
As Byte

Public Function Ecrire Port(nPort As Objet ActiveX usrUsb ‘usrUsb.ctl’

Integer, nData As Integer)

Public Function Bit Set(nBit As Integer) Objet ActiveX usrUsb ‘usrUsb.ctl’

Public Function Bit Clear(nBit As Integer) | Objet ActiveX usrUsb ‘usrUsb.ctl’

Public Function Init Usb(nComm As Objet ActiveX usrUsb ‘usrUsb.ctl’
Integer) As Boolean

Public Function Stop Usb() Objet ActiveX usrUsb ‘usrUsb.ctl’

Public Sub APropos() Objet ActiveX usrUsb ‘usrUsb.ctl’

- Description des événements
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Sub usbTest Click()

Le composant ActiveX ne possede pas d’événement spécifique pour la
communication avec I’interface pci4-USB. Cependant, I’événement Click peut étre

utilisé pour appelé une référence d’aide créé par le programmeur si 1’utilisateur

effectue un clique sur I’'image, celle-ci , du composant ActiveX.
- Description des données membres
bInterfaceOk As Boolean

La variable booléenne binterfaceOk permet de connaitre, sans repasser par la
fonction Init_Usb, si I’interface pci4-USB a été détectée correctement. La valeur
true signifie que I’interface est présente et active sur I’ordinateur. Par contre,

I’interface est inactive si blnterfaceok est égale a false.
bTimeOut As Boolean

La communication avec I’interface pci4-USB utilise des délais dans les
communications en entrées pour €viter toutes erreurs qui pourrait causer une
boucle sans fin. La variable bTimerOut peut €tre utilisé pour créer une fonction
personnaliser avertissent I'utilisateur que I’interface pci4-USB vient d’étre
déconnecté du port USB. La variable booléenne bTimeOut est égale a true si le
temps d’attente pour une réponse dépasse les limites permises. Cependant, un

résultat false signifie que I’interface est toujours présente.
- Programme de test

Un programme de test, utilisant le composant ActiveX pcidusb.ocx, est répertorié

dans le dossier EA\TEST\VDb\ ou E:\ représente la lettre de votre lecteur CD-ROM.
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Pour utiliser ce programme il suffit d’exécuter le programme prjTestInterface.exe
apres avoir installé correctement le composant ActiveX aupres de Microsoft
Windows. Egalement, il est possible d’utiliser directement les sources du
programme de test en ouvrant le groupe de projet grpOcx.vbg sous Microsoft

Visual Basic 6. L’interface graphique est illustrée ci-dessous.

... Interface de test pour carte USB =10l =]

— Lecture

f B B 4 3 2 1 10

Pttt @ 90009 @@
Frif @@ @9 @@ @@
Poil @ @ @99 @ @@

— Ecriture

Détection .l ' ﬂ'n
Poté - O OO C oo @f

Pate I~ I [/ CICIC rep
PotC [ [ I I I I I I Ecrire part
| o Rl | R2

Lecture Cluitker

L’interface graphique permet la lecture, 1’écriture sur les ports ou des bits en
utilisant le composant ActiveX pcidusb.ocx pour accéder I’interface et le
microcontroleur. Avant d’effectuer une communication, 1’utilisateur doit cliquer
sur Détection pour procéder a I’Initialisation de la carte USB. Une fois initialiser

correctement, 1’utilisateur pour travailler avec les fonctions de communications.

- Fonction du PIC16C64A

InitPic:
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Fonction qui permet de remettre tous les ports du pic a 0 et choisir la direction

(Entrée ou Sortie) des ports.

Bit_Set(char cBit):

Fonction permettant de mettre le bit spécifi¢ a un.

Bit_Clr( char cBit):

Fonction permettant de mettre le bit spécifié a zéro.

Ecri_Port( char cPort, char cData ):

Fonction permettant d’€crire la valeur spécifi¢e sur le port spécifié.

unsigned char Lire_Port( char cPort):

Fonction permettant de lire un port spécifié. On retournera la valeur lue sur ce port.

Setup:

Permet de faire I’initialisation de la communication.

TxNextBit:

Permet de transmettre les prochains bit a étre transmit.

PutChar(char):

39



Permet d’envoyer une valeur sur le port série.

GetChar:

Permet de recevoir un caractere venant du port série.

StartBitDetect:

Permet la détection du StartBit lors d’une réception série.

RcvNextBit:

Permet de recevoir le prochain bit qui doit étre regu.

Nom de la fonction Ficher contenant le code Fichier contenant les prototypes

InitPic: usbSerie.c usbSerie.c
Bit Set(char cBit): usbSerie.c usbSerie.c
Bit Clr( char cBit): usbSerie.c usbSerie.c
Ecri_Port usbSerie.c usbSerie.c
Lire Port usbSerie.c usbSerie.c
Setup: usbSerie.c usbSerie.c
TxNextBit: usbSerie.c usbSerie.c
PutChar(char): usbSerie.c usbSerie.c
GetChar: usbSerie.c usbSerie.c
StartBitDetect: usbSerie.c usbSerie.c
RcvNextBit: usbSerie.c usbSerie.c

- Donnée membre stratégique
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char TxByte: Contiendra le caractére a transmettre.

char RxByte; Contiendra le caractére recu.

char TxRxBitCount: Contiendra le nombre de bit recu ou transmit.

char SerialStatus: ~ Variable qui servira de registre de statut pour le port série
char cControlBit: ~ Variable qui contiendra 1'état de la ligne de contrdle qui

servira a valider si on regoit une donnée ou une commande.

- Programme de test

Le programme de test s’exécute en utilisant le programme pci4.exe. Ce programme
de test a été créé pour €tre capable de voir 1’état des ports du pic et aussi de pouvoir
écrire des valeurs sur la carte d’interface. Aussi, dans le but de tester toutes les
caractéristiques de la carte, nous avons créer deux zones, une zone de lecture et une
zone d’écriture. La zone de lecture vous permet d’afficher les valeurs soit bit par
bit en utilisant la zone de case a cocher consacré a la lecture. Aussi, des boites vous
indiqueront les valeurs lues par port. Une zone d’écriture est aussi disponible et
vous permettra d’écrire un bit a la fois ou d’écrire sur tous les ports. La zone de
case a cocher vous permet en cochant ou décochant une case a cocher d’affecter un
bit a la fois. Aussi des boites d’éditions permettront d’écrire directement sur les
ports de la carte en appuyant sur le bouton Ecrit. Une fonction K2000 vous
permettra de faire une démonstration de la carte. Cette fonction créera un

déplacement vers la droite ou vers la gauche sur I’affichage a LED de la carte.

- Programme d’ajustement du baudrate

Deux programmes d’ajustement du baudrate sont disponibles. Ces programmes

visent a ajuster les constantes BaudRate et BaudRatePlusHalf.

Pour utiliser le programme trouvebaud.c
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1- Programmer le PIC16¢c64 avec le programme trouvebaud.c. Pour savoir la
procédure a utilisé pour la compilation du programme et la programmation du pic,

se référé a la section Procédure de développement.

2- Utilis€ une application terminal série qui permettre un ajustement rapide des

paramétres de communication.

3- Ouvrir le port série virtuel créer par le pilote FTDI. Pour connaitre le port série
virtuel, il suffit d’ouvrir I’item systéme du panneau de configuration et dans la
section Port (COM et LPT) repéré le com portant comme nom USB Serial Port .
Configurer votre terminal avec les parametres 8 bit de donnée, 1 stop bit, pas de

parité et baudrate auquel vous voulez configurer le pic.

4- Mettre la carte d’interface sous-tension apres avoir replace le PIC16c64 a sa

place. Si la carte est déja sous-tension, effectuer une remise a zéro.

5- Plusieurs valeurs seront envoyer vers le PC. Ces valeurs auront le format suivant
Xyyy. La position X contiendra la valeur de test « (Oxab ou 171). La position y
contiendra le caractére qui contiendra la valeur de la constante BaudRate a ajuster,
répété trois fois. Trouver la trame parmi les trames envoyées. Utilisé une table
ASCII pour découvrir la valeur du baudrate en décimal. Si vous ne trouvez pas la
valeur de test, il se peut que 1’horloge de la carte d’interface ne supporte pas le

baudrate choisie.

6- Remplacer la valeur de la constante dans le programme principale de I’interface.

Pour utilisé le programme trouvebaudplus.c
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1- remplacer la valeur de la constante BaudRate dans le programme
trouvebaudplus.c avec celle trouver précédemment dans le programme

trouvvebaud.c.

2- Programmer le PIC16c64 avec le programme trouvebaudplus.c. Pour savoir la
procédure a utilisé pour la compilation du programme et la programmation du pic,

se référé a la section Procédure de développement.

3-Utilisé une application terminal série qui permettre un ajustement rapide des

parametres de communication.

4- Ouvrir le port série virtuel créer par le pilote FTDI. Pour connaitre le port série
virtuel, il suffit d’ouvrir I’item systéme du panneau de configuration et dans la
section Port (COM et LPT) repére le com portant comme nom USB Serial Port .
Configurer votre terminal avec les parameétres 8 bit de donnée, 1 stop bit, pas de

parité et baudrate auquel vous voulez configurer le pic.

5- Mettre la carte d’interface sous-tension apres avoir replacé le PIC16c64 a sa

place. Si la carte est déja sous-tension, effectuer une remise a zéro.

6- Transmettre n’importe quel caractere. Utiliser toujours le méme caractére. Apres
plusieurs essaie vous devriez recevoir une trame ayant le format xYYY ou x est le
caractére émis et Y sera la valeur de la constante BaudRatePlusHalf répété a trois

reprise.

7- Remplacer la valeur de la constante dans le programme principale de I’interface.

Apres avoir trouver la valeur des constantes choisie, I’interface devrait étre

fonctionnel au BaudRate choisie.
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Procédure de développement

Pour le développement logiciel un compilateur ¢ vers assembleur provenant de la
compagnie B Knudsen Data a été utilisé. Le compilateur CC5x, présent sur le CD-
ROM dans le répertoire E:2\UTILS\CC5X)\, permet la compilation de code jusqu'a
un maximum de 1024 octets pour la version éducative.

Pour installer le programme CC5x, il suffit de décompresser le fichier cc5x.zip,
présent dans E\\UTILS\CC5X\ ou E:\ représente la lettre du CD-ROM, sur le

disque dur. La seconde étape consiste a configurer un programme d’édition.

La compilation d’un fichier source s’effectue sous une boite MS-DOS, mais le
programme EditPlus a été utilisé pour faciliter 1’édition et la compilation du code.
L’image ci-dessous illustre la configuration utilisé avec EditPlus pour compiler un

fichier source avec CC5x
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Preferences x| |

Categories Groupz and tool items:
- General IF"in: Micro | Group Name...
- Fonts _—
. Colors Add Toal »»
Print [
=~ Filez
- Settings & spntax il | bxi
- Templates
- Project
= Tonls Menu text: IEEEH Cormpiler
- |zer toolz ! :
- Keyboard Command: IE."\CCEH"\ECEH.EHE _I
- Spell checker Argument; I-a F[FileM ame] LI
 Taokar Initial divectary: [$(FileDir |
v Capture output COutput Patterr...
[T Cloze window ariest [ Prompt for arguments
I | Bt & tent filter
\, k. x Cancel 4-' Al ? Help

Cependant, un autre programme d’édition tel que ‘UltraEdit’ pourrait étre utilisé. 11
faut alors spécifier ’argument ‘—a’ au compilateur CC5x pour assembler un fichier

source.

Le fichier cc5x.pdf au format ‘Acrobat’ est disponible sur le CD-ROM dans le
répertoire E:\DOC\CC5X\ . Il explique en profondeur les options de compilations

et les instructions en C pour le microcontréleur PIC.

- Recompilation du programme

La recompilation du programme, code C vers assembleur, se fait en utilisant le

compilateur CC5x. Une fois I’installation du compilateur fait avec 1’éditeur
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‘Expliqué dans 1’étape de développement’ , le code C peut étre recompilé par le
menu Tools->CC5x make. Le résultat en assembleur sera mis dans le dossier du
fichier source. La compilation du code assembleur vers 1’opcode est expliqué dans

I’étape de la Mise en ROM.

- Mise en ROM

Pour la mise en ROM, soit en mémoire morte, le logiciel MpLab doit étre utilisé

pour transmettre le programme vers le programmeur PicStart plus.

La procédure ci-dessous peut étre utilisé pour programmer le microcontrdleur
PIC16c64 servant dans I’interface USB. La premicre étape consiste a compiler le
code en assembleur ‘*.asm’ pour obtenir les opcode ‘*.hex’ nécessaire pour la

programmation de I’Eprom a I’intérieur du microcontroleur.

Le chargement du fichier assembleur se fait par le menu File->Open et non par
I’icone de la barre d’outils. Une fois le fichier ouvert, il doit étre compilé en code
machine ‘*.hex’ par le menu Project->Build Node. La boite de dialogue ci-dessous

aparaitera pour configurer la compilation.

Invoke Build Tool ki

Language Suite: | Micrachip =l Language Tool| MPASM |
~ Dpliong

Description | | | | | Diata L=l
Define ! On -
Hex Format | INHBEM INHXBS 1 INHX32
Error File # On o Off
List File ¥ On 2O
Cross-reference File 0 On ¥ Ot
Warning level ! all WArmEErr 1 err
Case sensithviny = On o Off
Macro expansion 1 On ]
Detault radis HEX DEC L OCT
Tah =size 1 On

-
Command Line
fev M dne dov AplGCGAA ]
Additional Command Line Options |
Cancel Help |




En cliquant sur OK, le fichier se compilé en code machine selon le type de

microcontroleur choisi.

La seconde étape consiste a connecter le programmateur PicStart Plus sur un port

série disponibles, COM1 ou COM2. Une fois branché, il faut I’activer via I’option

du menu PICSTART Plus -> Enable programmer. Aprés avoir reconnu le

programmateur PicStart, le logiciel ouvrira une fenétre pour configurer le type de

microcontroleur, le type d’oscillateur et quelques options supplémentaire pour le

fonctionnement interne du microcontroleur. Les options choisis pour I’Interface

USB sont :
Option Valeur

Oscillator HS Oscillateur HS,
XT pour crystal

Watchdog Timer Off Inactif

Power Up Timer Off Inactif

Code Protect Off Actif pour
production

Brown Out Detect Off Inactif
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Apres s’€tre assuré que le microcontrdleur est bien effacé, en choisissant I’option
‘Blank’, le microcontroleur peut étre reprogrammé avec le nouveau code. Pour
démarrer la programmation, il faut cliquer le bouton ‘Program’. Une boite de

dialogue affichera I’avancement de la programmtion.

B@8168 2825 OB2ZF 00A3 3062 BSA3 BB2ZF DOAW 3610 L 7. A

0018 B5A4 BSA3 1983 281F 2187 2825 1282 BeAk  ..... %..

0620 1003 2824 2200 2825 2218 1283 OE21 BO83 ',

AA28 BEABR BEZ0 @089 26B1 2194 1283 14AF 21E3 . arsmas PICSTART Plus Device Programmen

0028 1283 BOA6 OS2F 0OAR 3008 OSAS 1DO2 282F  ..f..../ - -

0038 0826 3020 1903 ZB4F JA10 1903 2858 JAT  Gw.0..[p Device Specification

a8a0 1903 2867 3A10 1903 287E 3A01 1983 2888 B | Device [GEEEZTIM 7] Confiquiation Bits |
00N8 3AB7 1003 2800 3A56 1003 28A7 282F 21E3 s
0850 1283 B0AG 0S2F DOAS 3008 OSAS 1003 282F 15 o & heckam Erosom 5tolstics
OB58 0826 2000 282F 21E3 1283 0DAG OB2F DOAR DevicelD | 7F7F7F7F  |Pasz  0ODODD
0060 3008 ASAB 1DG3 282F 6826 2118 28B2F 21E3 ;

8068 1283 DOAG OB2F OOAS 3008 OSAE 1DO2 282F Ehsclenmi BRI e Do
U870 D826 216E 1283 0OAG B826 21A1 1283 BB2F Voltages Total  DOG0OO

NATE AOA7 001 B5A7 1903 2876 282F 21E3 1283
BE80 00AS BB2F 0OAS 3068 G5A8 1083 282F B1A9
BB88 0826 2153 282F 21E3 1283 0OAG BB2ZF DOAB
BESH 3008 OSAB 103 ZEZF 3001 DBAY BEZ6 2153
A@A98 282F 21E3 1283 00A6 BB2F OOAE 3008 OSA8
BEAB 1003 282F 3002 00A7 B8B2&6 2153 2B2F 3J0AB
BOAB 21A1 1283 BB2F BOA7 3001 O5A7 1903 2809
BABD 282F JOFF 1283 G085 308 1683 0085 3J0FF
BEB8 1283 G084 1683 0186 3IOFF OOB1 30FF 1283
BECE OO87 1683 @187 30FF 1283 D088 1683 0188

VDD Min |50« Aeset i
VDD Max |50 |
VPP 13.00 [} Close |
SATEGE | [Wo SATP File Beng Used

| monk | st | progam | yeiy |

0OCH 1200 DOUS 1283 0OAY 3001 BOAR 3008 D229 o s 1|
NEDE 1803 280F 0829 1963 2808 GOABR 1083 1283 |
00D8 ODAR DBAB 2806 @%AR 1283 BB2A D486 3008 Oscillatar | H5 2l
O0ED 1283 0229 1CO3 28F7 3010 0229 1803 28F7 . Watchdog Timer [ ff =l
GBES 3808 02A9 0829 1983 28F3 OOAER 1002 1283 Doo - =il
OOFD DA OBAB ?8EE 09AA 1283 GR24 OMBT 3010  .....=.. Bonsc b Ter | ot =
0OF8 1283 @229 1CE3 290F 3018 0229 1883 290F  .)...).. Code Protect | or B
0100 3010 B2A9 0829 1983 2008 DOAB 1002 1283  ..)..... Brown Out Detect [ pif =il
B168 GDAR ABAB 2986 @9AA 1280 BE2A D488 BO6R  ..... ... |
0118 1283 BOAY 3081 0OAA 3008 0229 1803 2924  ..... y-3$

8118 0229 1903 2021 OOAE 1083 1283 0DAA DEAB ) I FRPAp

Finalement, I’option ‘Verify’ permet de vérifier si le contenu de la ROM est

identique au code chargé par le logiciel MpLab.
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